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Note - this HTML manual is a combined manual for the Macintosh and Windows versions 
of The Athlete's Diary. The features of these two versions are largely the same, so 
virtually everything you read will apply to both versions, sometimes with minor wording 
differences (for example, you "Quit" a Macintosh application, but you "Exit" a Windows 
application). Occasionally in this manual, you will come across a feature marked "Mac 
only" or "Windows only," and there are several sections where you will find "parallel 
instructions" where you should obviously read the section that applies to your computer.

As you read the manual, you will see two icons:

This "Advice" icon gives you tips on using the software 
effectively.

This "warning" icon lets you know about very important things 
which you should pay special attention to. It often calls attention 
to common mistakes which some of our users make; we hope 
you'll avoid them!



Chapter 1: Software Installation
Windows 95/98/ME/2000/NT

Macintosh

Windows 95/98/ME/2000/NT
To install The Athlete's Diary on your hard disk, first insert the diskette with The Athlete's 
Diary into your PC. Double-click on the INSTALL.EXE program. Follow the on-screen 
instructions given to you by The Athlete's Diary Installer program; explanations are provided at 
each step of the process.

Windows 3.1
Copy the files from the floppy disk to a folder named C:\TAD on your hard drive. Double-click on 
TADWIN.EXE to start the program.

Macintosh
No special installation program is necessary; just select the file or files you want and drag them to 
your hard disk. To make things even simpler, select the icon of The Athlete's Diary floppy disk 
itself, and drag it to your hard disk; this will create a new folder called The Athlete's Diary 
which will contain within it all the files you need.

To start The Athlete's Diary, double-click on its icon, or on any of the icons for any log (such as 
the sample logs in the Sample Logs folder when you're first trying out the software, or your own 
log once you have created one).

 



Chapter 2: Setting Up Your Log

Starting a New Log
This chapter tells you how to get started using The Athlete's Diary. If you prefer to follow 
step-by-step instructions, turn to Appendix II first, and then return here for more details. Otherwise, 
keep reading!

Starting a new log is slightly different in our Macintosh and Windows versions. In both cases start 
The Athlete's Diary as described in Chapter 1, and then do this:

Windows

If you haven't started a log yet, you'll see a menu with only two items 
in it File and Help. Select New under the File menu to start a new 
log. If you have previously opened the sample log, it will reopen 
when you start the program, but it will be automatically closed when 
you select New.

Macintosh
When you double-click on The Athlete's Diary, a dialog will 
appear which offers you three choices - Start a new log, Open an 
existing log, or Quit. Select Start a new log.

Setting Your Preferences

The Athlete's Diary offers you a number of customization options, which you will be asked to 
set up whenever you start a new log. These preferences are saved with your log, and can be changed 
at any time by selecting User Preferences under the Configure sub-menu of the File menu 
(Windows) or by selecting Preferences in the Window menu (Macintosh). To set preferences, 
just click on the desired choices, and then click on the OK button (Done on the Mac).

The options you have are these:

Response to Close/Quit With Unsaved Changes: If you modify your data, and 



then attempt to either close the file or exit the program, there are two possibilities. Selecting 
Automatic Save (Autosave) will automatically save your data; Request Confirmation 
will show a dialog window that allows you to choose whether or not to save the data.

Make Automatic Backup Copy of Log: Whenever you make changes to the log and 
save the new copy (either automatically or manually), if Automatic Backup is selected 
the previously saved version of your log is renamed XXX.BAK (where XXX.DAT is the 
name of your regular log). On a Macintosh, your log can have any name you want; the 
backup copy has the same name, but with the word "Backup" appended to the end. 
Automatic backup provides an extra level of protection. For example, if you accidentally 
delete an entry from your log, your backup copy is unaffected.

If you have your own automatic backup system, such as software which copies new or 
modified files to tape every night, the automatic backup feature within The Athlete's 
Diary is probably not needed; otherwise, we strongly suggest that you leave this feature 
enabled. Logs are fairly small (<100K); having two copies on your disk will not take up 
significant room.
Distance Conversion to Standard Units: When you enter distances in units other 
than your preferred units (see next section), those distances can be immediately converted to 
the preferred units (e.g., 10K becomes 6.2M) if you select On Data Entry. If you select 
Summaries Only, distances are entered in your log as you enter them, and implicitly 
converted when the distances are totalled.

Date Format: There are two date formats: American-style, with month first (3/21/95), 
and the rest-of-the-world-style, with day first (21/3/95). This preference cannot be 
changed after there are entries in the log.

Start Week On: Weeks can start on Monday, Saturday, or Sunday. This affects the way 
data are grouped into weeks for totals, and also the way entries in your log are divided by 
weeks for display and printing.

Default Period for Totals & Graphs: Totals and graphs are displayed and calculated 
either on a weekly or monthly basis. You can switch between the two, but the first time you 
display them, it will be in the time interval set by this preference.

Setting Up Your Sports

The Athlete's Diary allows you to track up to eight different sports or fitness activities, each with 
its own units of distance and pace, as well as a unique one-letter abbreviation. When you start a new 
log, you will be asked to set up your Sports List. This list is saved and can be modified at any time 
by selecting Sports under the Configure sub-menu of the File menu (Windows) or by selecting 
Sports in the Window menu (Macintosh).



Configuring Sports (Windows)

Configuring Sports (Macintosh)

The name of the sport, the abbreviation, and the pace units are irrevocable choices you cannot change 
them once you have started a log. Because of this, be sure to give thought to your choices when you 
start your log.

The first time you run the program, the Sports List box at the lower right (lower middle on the Mac) 
of the screen will be empty; as you add sports it will fill up with your information.

Select a sport from the scrolling list provided, or simply type in the name of any other sport not on 
the list, or if you just want to use a different name (Biking instead of Cycling, for example). The 
program will choose an abbreviation for you (on Windows; with a Mac, you do so yourself), which 
will be used in entering and identifying that sport. You can change it if you want to. No two sports 
can have the same abbreviation, so if you select both Weights and Walking, for example, one of 
them must be represented by a letter other than W.

Next, select a unit of measurement for the distances for that sport miles, kilometers, yards, meters, 
and Units/None. Units/None is provided for activities like Aerobics in which no distances are 
involved, or for sports in which you wish to record the distance in other units, like stairs climbed, 
calories burned, weight lifted, etc. You should also select Units/None for sports with multiple 
distances like duathlon and triathlon.

Finally, select pace units in which your speed for that sport will be calculated. Your choices are 
minutes per mile, minutes per kilometer, miles per hour, km per hour, or None (for non-distance 



activities).

After you have made your selections for a sport, click on the Add button to add it to your list don't 
forget this step! Up to eight sports can be added to your Sports List in this way. When you are done 
adding sports, click on the Done button. If you make a mistake while entering a sport, click on the 
name of the sport in the Sports List box, and then click on the Delete button (and then re-enter it 
correctly, if thats what you want).

If you participate in a number of sports only occasionally, you 
might want to select Misc (Miscellaneous) as one of your sports. 
This will enable you to keep track of your one weekend a year 
cross-country skiing, or an occasional basketball game, without 
requiring separate totals for each of these sports. The usual units 
for Misc is None, since the only common denominator for the 
various sports is time.



Chapter 3: Entering Your Workouts

Entering Your Workouts
The Data Entry window always appears on the upper-left of your screen, and presents you with a 
series of fields into which information is entered. The Athlete's Diary provides you a place to 
record the date, sport, category (training, intervals, or race), distance, time, and pace of your 
workout, along with a description of the route or workout, and a comment as well. If there is 
anything else you want to keep track of your weight or your heart rate, for example you can do so in 
the comment field using the Keyword feature, which you'll read about in the next chapter.

Data Entry Window (Windows)

Data Entry Window (Macintosh)

Use the Tab key to move between fields (or use the mouse to click on each field into which you 
want to enter data). You can also use Shift-Tab (hold down the Shift key while pressing Tab) to 
move backwards from field to field. When you have filled in the desired fields, hit the Return or 
Enter key or click on the Enter button; the entry will be added to the log (the Return key is not 
active when you are in the Route/Workout or Comment fields; you must use the Enter key or Enter 
button).

You can edit information in the fields by selecting text with the mouse, and then using either the 
Delete key on your keyboard, or the X, C, and V keys (for cutting, copying, and pasting).
Some of the fields (Sport, Category, Route/Workout, and Comment) have their own pop-up menus, 
which are activated by the icon shown at the left. The Sport and Category pop-ups can be used 
simply to enter data in that field; the other two pop-ups serve a more complex role, as will be 
explained below.

It is not necessary to fill in all fields for every entry; only the date 
must be filled in. If you are sick, for example, you might just put 
Weak from the flu in the comment, and enter that.



A Help Bar (Mac only) showing context-sensitive help appears along the bottom edge of the 
window. The Help Bar provides information either about the current field (date, sport, etc.), or, if 
the cursor is positioned over one of the buttons, the action that will result if that button is pushed.

The Help Bar is primarily designed for new users. You can turn it off by using the Configure 
sub-menu in the File menu; use Save Settings in the same sub-menu to make this change 
permanent.

Here are the details about entering information in the various fields:

Date: The date must be entered in the form 3/21/95 or 21/3/95, depending on the format 
you selected in the Preferences window. To prevent errors, you will be warned if you 
enter a date more than three months earlier than the first entry in your log, or more than 
three months later than the last entry.

If you enter a single number only (e.g., 7), that number is interpreted as the day, and the 
current month and year are added when you tab to the next field. If you enter two numbers 
(e.g., 3/21), the current year is added

The date defaults to the current day when you first open the program; after that, the default 
is the day just entered. To increment or decrement the day one or more times, use the mouse 
to click the up and down arrows to the right of the date field (Mac only), type the character 
+ or , or press the up and down arrow keys (Windows only). If you use the mouse, you 
can click and hold to produce rapid scrolling.

Sport: You can either enter a single letter (your chosen abbreviation) or select the sport 
from the pop-up menu. If you enter a single letter, either lower-case or upper-case will do.

You cannot enter a sport not in your list, but you can leave the Sport blank if you want to 
make an entry without a sport (like a rest day). If there is only one sport in your Sports List, 
that sport is automatically filled in, but you can delete it.

Category: You can either enter a single letter (T, I, or R for Training, Intervals, or Race) 
or select the Category from the pop-up menu. If you enter a single letter, either lower-case 
or upper-case will do.

Distance: Enter a number followed by a letter representing units: M for miles, K for 
kilometers, Y for yards, and m or e (lower-case) for meters, e.g., 10K, 1500Y.

If you don't type any letter, your standard units for the entered sport are assumed and that 
letter is added. For example, if a sport has miles as its preferred unit, typing 3.5 followed 
by Tab will enter 3.5M into the distance field. Three miles can be entered either as 3 or 
3.0, as you prefer.

Lower-case k or y is acceptable and is converted to the corresponding upper-case letter. 
Lower-case e is interpreted as meters. Lower-case m is interpreted in a somewhat 
complicated way:

Miles if the standard units for the sport are miles
Meters if the standard units for the sport are meters
If the standard units for the sport are kilometers or yards, then if the distance is 
>100, m means meters; if the distance is <100, m means miles.



If your conversion preference is On Data Entry, your entry is immediately converted to 
your preferred units. For example, if your preferred units are miles and you enter 10K, as 
soon as you press the Tab key your entry will read 6.2M.

For sports for which Units/None has been selected as the units, you can enter anything you 
like in the distance column, or leave it blank. If you enter a number, you will be able to total 
and graph the sum of the values you enter, which might represent weight lifted, stairs 
climbed, calories consumed, or any other numerical value you want to use to measure a 
particular activity. In other cases, you might want to enter letters, like OD for Olympic 
Distance triathlon, or HIM for Half Ironman.

The distance can be marked as an estimate by preceding it with the approximate sign, ~, 
e.g., ~10.4M. Estimates are treated normally for the purpose of calculating totals, but are 
excluded when searching for Personal Records (see below).

If you don't know the distance, you don't need to estimate it 
yourself. Instead, enter your time and estimated pace, and the 
program will come back and fill in the distance for you (marked 
with an ~ since it will be an estimate). Most people can estimate 
their own pace much better than they can estimate distances.

The program will not let you enter a distance unless you have entered a sport.

Time: Entered in the form Hours:Minutes:Seconds, e.g., 1:03:43, or Minutes:Seconds, 
e.g., 42:17. Times greater than one hour but less than 100 minutes can also be entered 
simply as minutes, e.g., 63:43. 1:03 means one minute, three seconds, and not one hour, 
three minutes. Using the approximate sign ~ makes this an estimated time, e.g., ~34:30.

Entering colons ( : ) in the time is optional. A 3- or 4-digit number is assumed to be 
Minutes:Seconds (e.g., 2325 becomes 23:25 after you press Tab), while a 5- or 6-digit 
number is assumed to be Hours:Minutes:Seconds. If you enter a 1- or 2-digit number, the 
program assumes this is an approximate number of minutes, not seconds. In other words, 
enter 15 and after you press Tab the value will read ~15:00.

Fractions of seconds (tenths and hundredths) can be entered, either with or without colons, 
e.g., 4512.3 or 45:12.3, 537.18 or 5:37.18.

Two more shortcuts for entering time (Mac only) end the entry with m for minutes or h for 
hours (only one or the other). Entering 2.5h and pressing Tab will display 2:30:00 (two 
and a half hours); entering 23m and pressing Tab will display 23:00.

Pace: Normally, you will not enter a value into the Pace (speed) column; rather, the 
program will calculate it in for you after you have entered your sport, distance, and time. It 
is possible, however, to reverse the process. If you exercise over an unknown distance, 
enter a time and an estimated pace, and the program will calculate the approximate distance. 
If you exercise for a known distance but don't have an accurate time, just enter the distance 
and an estimated pace, and the program will calculate the approximate time.

The program knows that if you are entering pace it must be an estimate, so don't put a ~ 
when you enter it. The program will place a ~ in front of the data it has estimated (time or 



distance).

If you enter a pace, it must be in the relevant format. If the pace for that sport is a speed 
(miles per hour or kilometers per hour), the entry will look like a simple number, e.g., 
21.3. If the pace is in minutes per mile or kilometer, pace must be entered in the time 
format, e.g., 7:45 (again, you can leave out the colon if you wish).

Some people prefer to enter just the time for their workouts, even 
for sports like running. This is permissable, but your totals and 
averages will be more useful if you enter a pace estimate and let the 
program calculate your estimated distance. Most people can easily 
estimate their pace to within 15%, and isn't that better than no 
estimate at all?

Interval Workouts
Swim sets, track workouts, etc., can't be described 
by a single pace. Perhaps you run 440s with a 
warm-up/cool-down and jogging between intervals. 
There are four ways to enter workouts like this:

Make two entries in the log, one for the fast 
part of the workout, and another for the 
rest.
Make a single entry for the total workout, 
and just accept the fact that the pace 
displayed is an average pace for the whole 
workout and not a real pace.
Make either one or two entries, and record 
times for each set or interval in the 
Comment field. This will provide you with 
a record of your splits, but won't do any 
calculations on them.
Make a separate entry in the log for each set 
or interval.

The program will not let you enter a pace unless you have entered a sport.

Route/Workout: This is a free-form entry where you can describe the route you took, the 
workout you did, or the name of the race you participated in.

The Athlete's Diary will memorize up to twenty of your common workouts not only the 
route/workout description, but also the sport, distance, category, and any other fields that 
you wish to memorize.



Once a workout is memorized (described below in Chapter 4), you can enter that workout 
quickly and easily using the Route/Workout pop-up menu. First enter the date, then select 
the workout from the pop-up menu. On Windows, click the mouse down on the 
Route/Workout label (on Mac, click on the small arrow to the right of the label) and a 
pop-up list of the memorized routes will appear, as shown above. Hold the mouse button 
down, drag down the list to select the desired workout, then release the mouse button. The 
memorized information is filled in, and the cursor moves to the first blank field (most often 
the Time). Enter the time, modify other fields (like the Comment) as appropriate, and press 
Enter.

Using memorized workouts to enter data in your log is just a 
starting point. If today's workout varied in some way, feel free to 
change the appropriate part of the entry.

In addition to memorizing workouts for quick entry, you can also save an unlimited number 
of workouts into separate files called Saved Workouts (described below in Chapter 7). 
These can be recalled using the Use Saved Workout item in the Route/Workout pop-up 
menu. As with memorized workouts, you then modify the information as appropriate and 
enter it in your log.

Comment: A free-form entry where you can describe the weather, your feelings, who you 
ran with, or anything else. The Comment can also be used to track other numeric quantities, 
such as weight, resting heart rate, etc. This is done using Keywords, which you'll read 
about in the next chapter. Finally, the Comment can be used to track equipment use, which 
is discussed in Chapter 8.

To enter large amounts of information in either the route/workout or comment fields, simply 
keep typing; the field will auto-wrap (Mac only) and auto-scroll. You cannot use the 
Return key to insert a new line; both fields are essentially one long, continuous line of text.

Use the small scroll bars at the right edge of each field (Mac only) if you need to scroll 
backwards or forwards to view or edit the contents of that field. The limit to both fields is 
255 characters. you'll hear a beep if you reach the limit, and won't be able to type any 
more.



As you enter the Route/Workout and Comment, bear in mind that 
these fields can be used for selecting entries (Chapter 6). For 
example if your dog's name is Nicky and you always enter with 
Nicky in the comment when you run with him, you'll be able to 
look at all the runs you've done with him, and even total up his 
mileage as well as your own! Try to be consistent. In this example, 
if you wrote with the dog in the comment one day, that run 
wouldnt be included in Nicky's totals.

Saving Your Log
If you have selected Automatic Save as a preference, your log is automatically saved when you 
select either Close or Quit (Exit on Windows) from the File menu. If you haven't selected 
Autosave, when you Close or Quit you'll be asked if you want to save the changes you have made; 
click on Save if you do. You can also select Save in the File menu at any time to update your 
current file.

If, like many people, you start using The Athlete's Diary by 
entering months' worth of data from your written log, you should 
save your work frequently don't leave yourself at the mercy of a 
computer crash!

Revert to Saved and Quit (Exit) without Saving provide two different methods to get out of a 
situation where you changed something in your log (or think you did), but don't want to save your 
changes. Revert to Saved reads back in your original log, while Quit (Exit) Without Saving 
immediately exits without saving any changes you have made. If you have made changes, you will 
be given a chance to confirm your request.

Quick and Easy Daily Entry
Here is a step-by-step example of data entry:

1. Double-click on your log which will start the program and have it bring up your log.
2. Assuming you are entering data on the day of the activity, the date will be correct, so press 

Tab.
3. Type in the code letter for the sport (e.g., r for Running) and press Tab. Using lower-case 

will save you the step of using the Shift key.
4. Assuming the category is Training, press Tab again.
5. Type in the distance, and unless it was in units other than your normal ones, omit the letter. 

Thus if you ran 3.5 miles, type 3.5 and press Tab.
6. Type in the time (e.g., 2720) and press Tab. The pace will be automatically calculated.
7. Type in the Route, then press Tab, then your Comment, then press the Enter key to add 

the entry to your log.
8. Press Q (Mac) or Ctrl-Q (Windows) to exit from the program and (assuming you have 

Autosave turned on) save your data automatically (if you don't use Autosave you'll have to 
click on Save when asked).

If you have done one of your memorized workouts, the process is even easier:

1. Double-click on your log which will start the program and have it bring up your log.



2. Select the route from the Routes pop-up menu.
3. Type in the time (e.g., 2720) and press Tab twice.
4. Type in the Comment, then press the Enter key to add the entry to your log.
5. Press Q (Mac) or Ctrl-Q (Windows) to exit from the program. Thats it!



Chapter 4: Data Entry - Special Topics
Memorized Workouts
It is the rare athlete who doesn't repeat certain workouts. The Athlete's Diary allows you to 
memorize up to twenty of your most common workouts, and then lets you enter those workouts into 
the log with a single menu choice. you'll see later that you can also display or graph just those 
workouts with a single menu selection.

A memorized workout consists of the route or workout description itself, as well as the sport, 
distance, category, and any other fields that you wish to memorize.

To memorize a workout, fill in the Data Entry window as if you were making a normal entry (don't 
worry about the date; it will be ignored). When you have entered the information that you want to 
memorize, click on the Memorize Route (Mac) or Memorize (Windows) button. A dialog box 
will appear. Enter the name you want to give to this workout, then click on the Memorize button to 
add the workout to your list (or click on Cancel if you change your mind).

Many people confuse the name of the workout with the contents of 
the Route/Workout field, or with the memorized workout itself. The 
name of the workout appears in the programs menus, and should be 
kept short. The contents of the Route/Workout field is a full 
description (as long as 255 characters). And the memorized workout 
itself contains not only the Route/Workout description, but typically 
the sport, category, and distance.

Memorized workouts, like Preferences and Sports, are stored with the log. This means that different 
logs (i.e., different people or different years) can have different memorized workouts.

If you make a mistake setting up a workout, you can modify it. Using Windows: Select the 
workout from the Route/Workout pop-up menu in the Data Entry window. Modify the data in the 
data entry screen as you wish. Now press the Memorize button, and, when asked for a name for 
the route, give it the same name as before. You will see a mesage reading "That name is already 
used. Do you want to replace the old data?" Click on Yes if that's what you want to do. Using 
Macintosh: Select the workout from the Route/Workout pop-up menu in the Data Entry window. 
The button which was labelled Memorize Route now reads Modify/Delete Route. To modify 
the workout, first make the changes you want to make, then press the Modify/Delete Route 
button. The Route dialog box appears. If you want to modify the name of the workout, you can do 
so at this point; when you're ready, press Modify (or Cancel if you change your mind).

To delete a memorized workout: Macintosh only: select the workout from the Route/Workout 
pop-up menu in the Data Entry window, press the Modify/Delete Route button, and then click on 



Delete. Deleting a memorized workout does not affect any entries in the log which used that 
workout.

To delete a memorized workout: Windows or Macintosh: when you select the route from the 
Route/Workout pop-up menu, hold down the Delete key as you release the mouse. You will be 
given a chance to change your mind.

Memorized workouts appear in the menu in the order in which you create them, so its a good idea to 
enter your most popular workouts first, so they will appear at the top of the menu.

Keywords
The standard numerical information entered and tracked in The Athlete's Diary is time, distance, 
and pace. But there are other things you may wish to keep track of in your log your weight, your 
resting heart rate, the time you spend in your target heart zone, and so on. The Athlete's Diary 
uses Keywordsto let you track this kind of information in the Comment field of your log.

A Keyword is simply an abbreviation that you pick (like Wt to track your weight), and then use to 
enter numerical information as part of the comment field, e.g., Ran well today. Wt=164. Once 
you do this, the Keyword information can be extracted, totalled, and graphed by the program.
To memorize a Keyword and add it to the menus in the program, select New in the Comment 
pop-up menu . Enter the Keyword (without an equals sign) in the dialog box, and then enter a more 
descriptive label which will be used to label your graphs of this quantity.

Memorizing a Keyword

Now select between the two types of Keywords averaged and totalled. An averaged Keyword is 
something like weight. If you enter it twice a week in your log, you don't want to see the total (!), 
you want to see the average of those two entries. A totalled Keyword might be something like ascent, 
where you are keeping track of how much climbing you do on your bicycle (or on foot). Here, of 
course, you do want to add entries together, just like totals of distance or time, rather than average 
them.

Click on OK, and your Keyword will be memorized.

To delete a Keyword, select it from the Comment pop-up menu in the Data Entry window, but hold 
the Delete key on the keyboard down as you release the mouse (you will be given a chance to 
change your mind!).

Entering Keyword Data

Keyword values are entered into the Comment field. Enter the Keyword, being sure to always use 
the same spelling, followed by an equals sign (=), followed by the Keyword value. don't use spaces 
around the equals sign.



More than one Keyword can be entered in the same comment. For example, your comment might 
read: Great workout. Wt=165, RHR=42.

Memorized Keywords also appear in the Comment pop-up menu in the Data Entry window. This 
makes it easy for you to enter them without having to remember your chosen abbrevation.

When you use the pop-up menu to enter a Keyword in the Comment field, the Keyword (plus an 
equals sign) is added at the current insertion point; it does not replace the entire comment.
The numbers you enter with your Keywords can be simple numbers (like 160), times (like 34:50), 
or percentages (like 75%). You might use a time Keyword to track the time you spent in your target 
heart zone, or to track particular splits of your workouts. If you have a hill climb that is part of a 
regular bike route, for example, you might enter Hill climb=41:30 in your comment each time you 
do that route. Now you'll be able to graph the average time per week it takes you to do the hill climb.

When you use a percentage keyword, the entry is treated as the percentage of the time found in the 
Time field. If you spend 75% of a particular workout in your target heart zone, for example, you 
might enter THZ=75% in your comment field. If you do this for every workout, you'll then be able 
to graph time per week or month of exercise in the target heart zone.

Keywords are stored with the log. This means that different logs (i.e., different people or different 
years) can have different keywords.

Weight Training and Exercise Machines
Weight training and exercise machines are not ideally characterized by time, distance, and pace. 
Nevertheless, The Athlete's Diary can easily be used to keep track of these activities. How you 
do so depends on what you want to keep track of, and what kind of calculations that you want to do 
(if any).

If you set the distance units for the activity to Units/None when you set up your Sports List, you can 
total or graph any number you put in the distance field. You might want to keep track of the total 
weight you lift, or the number of sets times the number of reps per set, for example.

You may also want to use the Keyword feature described in the previous section to track various 
numerical aspects of your training with weights or machines.

If you work with different kinds of machines, or different kinds of weights, there are two ways to 
keep them separate:

Create separate sports for each activity, e.g., Stairclimbing, Rowing, NordicTrack, or abs, 
lats, etc.

Put all the different activities into a single sport, but note in the Route/Workout field which 
machine or which muscle group you were working. This will enable you to select out all the 
workouts of a particular type (selection is described in Chapter 6).

Multi-sport Events
Multi-sport events (duathlons, triathlons, etc.) should be entered in a particular manner. First, enter 
the event as a Duathlon (Biathlon) or Triathlon, with your total time for the entire race. For the 
distance you might enter OD for example, for Olympic Distance, or HIM for Half-Ironman (or just 
leave it blank). You can also enter the distance in the Route/Workout field, where you have more 
room. This entry is for informational purposes only; neither the time nor the distance(s) which are 



part of this log entry will be included in your totals.

In order to calculate your pace for the individual segments of the race, and also to have your time and 
distances included in your totals, you now add a second, third, and possibly fourth entry into the 
log, one for each segment, with the individual sport entered as appropriate for that segment. Of 
course if you didnt get exact splits for this race, you'll have to use estimates. Use the Comment field 
to record your transition times.

An example of a typical triathlon entry:



Chapter 5: Displaying Your Log
Displaying Your Log
Once you have entered data into your log, you can view that information in five different ways, using 
five different windows the Log, Totals, Graph, Daily Journal (Single Entry), and Week-at-a- Glance 
(Calendar) windows. You can switch between these views of your data using either the Window 
menu, or the Button Bar (Mac only) which appears in the upper left of the screen. You can also 
activate any of the currently displayed windows simply by clicking on them to bring that window to 
the front.

The Log (List View)
The Log window provides a columnar list of all your workouts. Alternating weeks are separated by a 
horizontal line, and, on color or gray-scale screens, by alternating white and light-gray background. 
Races appear in red on color screens.

The Daily Log

Like a written log, entries always appear in chronological order. If you add a new entry which is out 
of place, it is automatically sorted into the correct position. When the log is first opened, the scroll 
bar is positioned so that the most recent entries (usually the ones of most interest) are shown. To 
scroll the log, use the scroll bar in the usual way; you can also use the up and down arrow keys on 
the keyboard.

When the Log window is the active window, clicking on any entry in the log brings up the Journal 
window, displaying that entry in full detail. Clicking and holding the mouse down on any entry in 
the Log causes a pop-up menu to appear on the screen, with four choices View, Modify, 
Duplicate, and Delete, with the following results:

View does the same thing as simply clicking on the entry displays that entry in the Journal 
window.
Modify copies that entry to the Data Entry window, where it can be modified.
Duplicate also copies that entry to the Data Entry window, but changes the date to the 
current default date. Making changes and entering that data leaves the original entry 
unchanged.
Delete is self-explanatory, but be aware that if you select it, you will be given a chance to 
confirm your request before the entry is actually deleted.

Across the bottom of the log window (Mac) or in the Display menu (Windows) are menus which let 
you control the display. These are:

#Lines/Entry: You can choose either one or two lines to be displayed for each log entry. 
One line per entry shows less of your route and comment, but more entries will be visible; 



two lines per entry shows fewer entries but more information per entry. The entire entry is 
visible in the Daily Journal window (see below), or when you print the Log (or Daily 
Journal).
Display mode: There are two modes of display which become relevant when you have 
used the Select Menu or the Selection Criteria window to select just certain entries. 
Display selected only does just that other entries do not appear in the log display. 
Highlight selected displays all the entries but uses a yellow highlighter to mark the 
selected entries (or an inverse video display on monchrome screens).
Pace/Calories: (Mac only) The initial configuration for the log display shows distance, 
time, and pace, just as they are entered in the log. However, a third menu allows you to 
replace the pace column with a column showing the estimated calories burned by that 
activity (for more information on configuring caloric information, and on how to display 
calories burned in the Windows version, see Chapter 8).

Daily Journal View
The Log window shows many entries, but some of the information is shown in an abbreviated 
format. To see complete details of a single entry, use the Daily Journal window. You can turn the 
pages of the journal forward or backward one entry at a time by clicking on the left and right arrows 
in the display (Mac), or by pressing the left or right arrow on the keyboard, or by clicking on the 
Next or Previous buttons (Windows). To move rapidly through the log, click and hold down the 
mouse, or hold the arrow key down (Mac only).

Daily Journal (Windows)

Buttons at the bottom of the window let you Modify, Duplicate, or Delete the displayed entry. 
These buttons function just like the pop-up menu in the Log window described in the previous 
section.

Week-at-a-Glance (Calendar) View
A calendar is a familiar way to look at your workouts. It has disadvantages (if you look at a weekly 
calendar, and its the first day of the week, you don't see much!), but it has the big advantage that it 
provides graphical feedback of certain aspects of your training how often you're swimming, when 
your last long run was, etc.

The Athlete's Diary provides two different calendars. One shows one week at a time; the other 



shows four weeks (an Athlete's month). The single week view shows more information for each 
workout, but fewer workouts; the four-week view shows more workouts, but less information per 
workout.

Both views shows totals and averages, along with the workouts themselves. Different sports are 
color-coded to help provide visual feedback.

Three pop-up menus at the bottom of the window (Mac) or the Display menu (Windows) control 
the display. The first menu toggles between one-week and four-week views. The second allows you 
to display all sports, or just a single sport. And the third, identical to one in the Log window, toggles 
between displaying selected entries only, and always displaying all entries, but highlighting the 
selected entries.

The entries in the calendar function just like the entries in the Log window. If you click on one, the 
Daily Journal window appears, displaying that entry in complete detail. If you click and hold the 
mouse down on a particular entry, you'll cause a pop-up menu to appear, which will allow you to 
view, modify, duplicate, or delete that entry.

You can enter workouts directly into the Week-at-a-Glance window instead of using the Data Entry 
window, if you prefer. This feature is primarily designed for use in setting up training plan for 
yourself, and is described in Chapter 7.

Scroll bars (horizontal for the one-week view, vertical for the four-week view) allow you to flip the 
pages of your log.



Chapter 6: Analyzing Your Training
Examining Totals
The Totals window displays a list of either weekly or monthly totals, as well as Year-to-Date totals, 
for each of your sports, as well as the totals summed for all sports. The number of times you did a 
particular sport, the total hours and distance, and the average pace are all calculated and displayed. 
Alternating weeks or months are separated by a horizontal line, and, on color or gray-scale screens, 
by alternating white and light-gray background. The scroll bar allows you to scroll through your list 
of totals. Totals are limited to a four-year span from the time of the first selected entry.

Three pop-up menus at the bottom of the window (Mac) or the Display menu (Windows) control 
the display. The first menu alternates between weekly and monthly totals. The second controls which 
totals are actually displayed in the window all your sports, one sport at a time, total totals (the totals 
summed for all sports), or any of your keywords. The third pop-up toggles the final column of the 
display between displaying average pace and displaying an estimate of the calories burned.

How Calculations Are Done

The number of workouts is calculated from only those entries in which 
either the distance or the time is entered Average pace is calculated from 
only those entries in which both distance and time are entered. If you put 
entries in your log with just a time (or just a distance), the time (or 
distance) will be added to the total time (or distance), but will not affect 
the calculation of the average pace.

Totals are calculated using only currently selected log entries (see 
Selecting Entries at the end of this chapter). This allows you to calculate, 
for example, the total mileage you have ridden your bike commuting to 
work, the distance you have run on hot days, etc.

Sports in which the distance units are Units/None are totalled according 
to the numerical values in the Distance field, allowing you to total up 
stairs climbed, calories consumed, or whatever else you wish to 
measure. Average pace is not calculated in this situation.

Totals are not calculated for multisport events including Triathlon, 
Duathlon, or any sport ending in the letters athlon or atlon (which covers 
a number of non-English languages). This is to prevent duplication, 
since the run, bike, and swim legs of those sports were also entered (and 
totalled) separately.

Graphing
The Graph window allows you to display in a graphical format all of the information which is 
displayed in the Totals window. What you see on the graph is controlled by the four pop-up menus 
at the bottom of the window (Mac) or in the Display menu (Windows).

The first menu controls the time period and duration of the graph. You can produce weekly graphs 
from 13 to 106 weeks, and monthly graphs from 12 to 48 months in duration. If the data in your log 



extends for a longer period than the period you display in the graph, you can use the horizontal scroll 
bar at the lower right of the window to scroll through your log (up to a limit of four years).

The second menu, identical to one in the Totals window, controls what information you are graphing 
all the sports, just a single sport, or one of your keywords. The third menu controls the type of graph 
time, distance, (average) pace, or #workouts. And the fourth menu (Mac only) switches between 
normal graphs (ones which show the values for each week or month on the graph), and cumulative 
graphs which show your cumulative totals up to that week or month.

Choices which are not relevant are grayed out (inactive). You cannot graph distance or pace for more 
than one sport at a time. To graph distance or pace, you can first use the Select menu to select just a 
single sport, or you can use the second pop-up menu at the bottom of the Graph window to display 
just a single sport in the graph.

You cannot graph sports for which the totals are zero, nor pace for a sport that has no units of pace.

And finally, you cannot display cumulative graphs of pace or averaged keywords.

All graphs, including keyword graphs, can include data from all your workouts, or from just selected 
entries. For example, you can graph your Average Heart Rate (AHR) for all your workouts, or you 
can select a particular interval workout and see a graph of your AHR during just that workout. you'll 
read more about selection on the next page.

Scales for the vertical axis are always automatically selected by the program.

The graph is Hot-linked to the log and calendar. Clicking on any point in the graph brings either the 
Calendar window (if it is already open) or the Log window (if the Calendar is not open) to the fore, 
scrolled to the week or month on which you clicked. The program only considers the x-axis position 
of the mouse click when you do this; the vertical position of the mouse can be anywhere within the 
graph box.

Selecting Entries
Normally, the Log, Totals, Graph, Daily Journal, and Week-at-a-Glance (Calendar) windows 
display your entire log. If you wish to view, print, or analyze just part of your log, you can use the 
Select menu to make some quick selections, or the Selection Criteria window to make more 
complex selections.

In the Select menu:

All clears any current selection and displays all your entries.
The By Sport sub-menu allows you to select all entries for a particular sport.
Races Only selects only your races.
The By Route sub-menu allows you to select all entries which match one of your 
memorized routes. In addition, you can quickly find workouts which match the one you just 
did, even if its not one of your regulars, by using Last Entered at the top of the By 
Route sub-menu. This choice selects all entries which match the last entry youve made in 
your log according to Sport, Distance, and the first half of the Route/Workout entry.



If you enter a workout using a memorized route, but then change 
some aspect of it, such as the distance, that workout will no longer 
match your memorized route and will not be selected when you 
select By Route; you'll need to use By Criteria (see below) to 
select those entries. You can add to the memorized route (adding a 
comment, for example, or adding something at the end of the 
Route/Workout description) and still match when you select By 
Route, but you cannot change something and still match.

Saved Workouts do not appear in the By Route menu. To select workouts which match a 
Saved Workout, use By Criteria (see below).
Personal Records (known as personal bests in the U.K. and elsewhere) brings up a 
dialog box which allows you to choose a sport, and a category. The software then finds all 
your best times, for all the different distances it finds in your log.
By Criteria displays the Selection Criteria window which allows you to enter one or more 
criteria for a selection..

Selecting by Criteria

The Criteria Selection Window

The Selection Criteria window displays each of the fields, with a pop-up menu to its right that 
contains a series of appropriate modifiers for that field. For example, the distance pop-up has Equal 
To, Approximately Equal To, Greater Than, Less Than, and From(/To) choices.

Entering a selection criteria

For the date, distance, time, pace, route, and comment fields, if you select one of the choices from 
the pop-up menu, one or two (as appropriate) data entry fields will appear on the right of the 
window. Tab to or mouse click on that field and then enter the desired selection criteria. Note that 
some fields will not appear at first until they are relevant so your screen will not appear exactly like 



that shown above. For example, until you enter a sport, the Pace field will not be displayed, since it 
isn't appropriate without a sport.

The rules for entering values in the fields are similar to making an entry in your log: times don't 
require colons when entered, distances don't require distance units if they are your default units, and 
so on.

There are just a few points which won't be completely obvious:

Distance and pace can only be used once a sport is selected.
Distances which are alphanumeric (e.g., OD for an Olympic Distance triathlon) can be 
matched, but only exact matching is used.
The comment pop-up includes the choices Keyword Greater Than and Keyword Less Than. 
To use these options to select entries based on keyword values, select one of them from the 
menu, then enter the keyword, an equals sign, and the target value in the field to the right. 
Thus if you keep track of your climbing (on bike or on foot) with the keyword Ascent, 
choosing Keyword Greater Than and then entering Ascent=2000 into the field will find 
all your rides or runs where the climb exceeded 2000.

There are five buttons at the bottom of the Selection Criteria window which cause something to 
happen:

Select uses the criteria you have entered and searches the entire log for matches. If you 
have already done a selection, and haven't yet entered any criteria, this button reads Select 
All and can be used to quickly go back to all the entries.
Fewer only searches through those entries which were already selected by a previous 
selection. This is equivalent to a logical and function the resulting entries match criteria set 
#1 and set #2.
More selects entries in addition to those already selected by a previous selection. This is 
equivalent to a logical or function the resulting entries match either criteria set #1 or criteria 
set #2.
Clear clears the criteria you have entered so far if you want to start over.
Cancel allows you to change your mind, leaving the selections unmodified.

Fewer and More are only active once an initial selection has been made. After that, they can be used 
repeatedly to make extremely complex selections from your data.

The number of entries which are currently selected, along with the total number of entries in your 
log, is always displayed in the lower left of the Log window (Mac) or in the Title Bar (Windows). 
"56/115," for example, means you have 115 total entries, of which 56 are currently displayed.

Once you have made a selection, the Daily Log and Calendar windows can be set to display only the 
selected workouts, or to display all the workouts but with the selected ones highlighted. The second 
mode lets you see your selected workouts in the context of your entire log, so, for example, you can 
see what you did on the days before and after the selected workouts.



Chapter 7: Planning Ahead
Training Plans
People training for marathons, century bike rides, and many athletic events want to follow training 
plans (also known as training programs) which have been developed for that purpose. You can find 
training plans in books, in magazine articles, and now, on computer as well. The Athlete's Diary 
gives you the ability to create your own training plans from scratch, to enter them yourself from 
magazine articles, to create them by duplicating some of your own previous training, or by using a 
training plan obtained from Stevens Creek Software.

The usual disclaimer applies do not embark on any training program 
without the advice of your physician.

Setting up a Training Schedule
You can enter future workouts using the Data Entry window, but its even simpler to use the 
Week-at-a-Glance (Calendar). Just click and hold the mouse on a blank area of the day on which you 
want to do the training (or on the line with the date itself). A pop-up menu will appear, showing your 
memorized routes, and, at the bottom, Other and Use Saved Workout.

If you select one of the memorized workouts with the mouse, that workout will be scheduled for that 
day. you'll notice the totals increase at the same time, so you can see how much training you're 
planning for yourself!

If you select Other, the program takes the date you clicked on, copies it to the Data Entry window, 
and activates the Data Entry window so you can enter that other workout. When you're finished, 
click on the calendar (or use the Button Bar) to return to the Week-at-a-Glance if you want to enter 
more workouts.

The scroll bar in the Week-at-a-Glance window normally stops at the 
end of the log. However, if you want to enter data for the following 
week, just click on the down or right arrow, and the calendar will 
advance one week.

After you actually do the workouts you have entered, you can use the Modify function from either 
the Log, Journal, or Week-at-a-Glance windows to modify that entry and add the appropriate 
information the actual time, a comment, etc. Of course you can also use Delete if you skip that 
workout.

Use Select By Criteria, then select out your future activities by date and you can print out a nice 
neat training schedule in either the Log or Week-at-a-Glance format.



Saved Workouts
Memorized workouts have two limitations you can have a maximum of 20 of them, and each one 
consists of only a single workout. Saved Workouts are a second category which allows you to store 
individual or multiple workouts in separate files (rather than in your log, like memorized workouts), 
from where they can be recalled and entered into your log in a single step. For example, you might 
set up a typical week saved workout that includes a masters swim workout Tuesday and Thursday, a 
track workout Wednesday, bike rides on Monday and Friday, and a long run on Sunday. Now when 
you're planning your future training you can enter all of these workouts in a single step.

To create a saved workout, enter a workout in your log, only entering information which you will 
want to recall each time. If the workout is a fixed distance, for example, don't enter the time. The 
actual date or day of the week doesn't matter, but if you want to save a series of entries as one saved 
workout, the relative date of each workout is important, so enter the date appropriately.

Unlike creating a memorized workout, to create a saved workout you must actually enter the workout 
in your log (by clicking on the Enter button or pressing the Enter key); just entering information in 
the Data Entry window has no effect.

After entering one or more workouts in your log in this way, use Select By Criteria to select just 
the workout(s) of interest (probably using Date as the criterion for selection). Now use Save 
Selected As in the File menu, choose Save As Training Program, and save this workout by 
an appropriate name. We suggest organizing your saved workouts in a folder called Workouts in 
your Athlete's Diary folder (or whatever folder the software is stored in). If you have a lot of saved 
workouts, you might create sub-folders for different sports.

Once you have saved the workouts, you can either delete the entries from your log, or modify the 
entry (click and hold the mouse button on the entry in the Daily Log or Calendar windows, then 
select Modify from the pop-up menu which appears) to finish entering all the information (e.g., the 
time and comment) for that workout.

You can recall saved workouts and enter them in your log from either the Data Entry window or the 
Week-at-a-Glance (Calendar) window. In the Data Entry window, click (and hold) the mouse on the 
Route/Workout pop-up menu, and your list of memorized workouts will appear; in the 
Week-at-a-Glance window, click (and hold) the mouse on a blank area on the day on which you 
want to enter the workout (or the first day if the saved workout file contains more than one day of 
workouts). At the bottom of the pop-up menu which appears you'll see Use Saved Workout(s) 
If you drag the mouse down to this item and release the mouse button, a dialog box will appear and 
give you an opportunity to select a workout file.

There is a major difference between entering saved workouts in the Data Entry and Week-at-a-Glance 
windows. In the Data Entry window, only the first workout is recalled, even if the saved workout 
file contains more than one workout. In the Week-at-a-Glance window, all the workouts in the file 
are recalled and entered.

The folder Workouts that is included on our disk shows you examples of the kind of saved workouts 
you can create. Read the file Workout Info in the Workouts folder to learn about the workouts we 
have included as samples.

Using a Training Plan from Disk
The Athlete's Diary can also use training plans which are already prepared on disk. To The 
Athlete's Diary, a training plan is similar to a log, but the entries are given relative dates instead of 
actual dates. That is, the last date of the training plan (usually the day of the race on which the plan 



culminates) is given a date of 0, the previous date is called -1, and so on.

To use a training plan, first open your own log (or start a new one). Now use Merge in the File 
menu and select a training plan. The software recognizes that the file you are attempting to merge is a 
training plan, and asks you for the date of the race for which you are training (the last entry in the 
training plan is assumed to be the race; if this is not the case, just enter the date you want the training 
plan to end, rather than a race day). Enter the date, and the training plan will be merged into your log, 
ending on the day of the race.

If the training plan is, say, 112 days long, and the race is only 100 days away, somethings got to 
give! If the software detects such a situation, it will give you three choices forget the whole thing, 
read in only the last 100 days of the training plan, or read in the whole training plan (even though 
you've already missed the first 12 days). Select one of these choices.

Creating Your Own Training Plan
You can create your own training plans in two ways. First, lets say you thought you did just the right 
thing in preparing for last falls marathon, and you want to reproduce the last 12 weeks of training 
exactly. Open the log containing the relevant training, and use Select By Criteria to select out the 
12 weeks (or whatever) prior to and including the race. Now choose Save Selected As from the 
File menu, and select the choice which reads Save as Training Program. Now you can open 
this years log, and merge in that training plan as described above. Of course, as you do the training 
you'll be modifying each entry to reflect your actual training.

The second way to create your own training plan is from scratch. Lets say you read a magazine 
article entitled 60 days to your first century (100-mile bike ride) and want to do that. Start a new log, 
and just enter those 60 days of training, starting the first entry on any day you like (it won't matter at 
all). Some published training plans of this type will include only a distance for each days workout. 
Others will include only a time. Some may include both. All of these methods are perfectly acceptable 
to the software. Now, once you have the training entered, use Save Selected As and choose Save 
as Training Program. Now open your real log, use Merge to read in the training plan, and tell 
the computer what day you'll be doing your century (or marathon or 10K or whatever), and you'll be 
all set. All thats left is to do the training!

Planned vs. Actual Training

Some people like to be able to compare the training they planned, vs. the 
training they actually did. The Athlete's Diary is designed to have 
only a single time, distance, and pace for each entry. Nevertheless, there 
are several different ways you might use the software to track actual 
versus planned:

Keep two logs, one with your planned training, the other with 
your actual, so you can print out graphs and totals from the two 
separately and compare them.
Keep two separate sports, for example, Running and Planned 
Runs.
Just record one sport, and when your actual training deviates 
from your plans, just make a note of that in the comment.



Chapter 8: Additional Calculations
Calorie Calculation (Windows)
One of the reasons many of us workout is to burn calories; naturally you want to know how many! 
While calorie calculation is inexact at best, it can be helpful to have an estimate of these numbers, and 
the Calorie Calculator does that for you.

Calorie Calculation (Windows)

When you select Calorie Calculator from the Special menu, the window above will appear. 
Using your weight (in pounds, kilograms, or stone), along with coefficients taken from the 
literature, the Calorie Calculator calculates the average calories you are burning each day for each 
sport and for all sports, using your totals for the latest week, the latest month, and for the entire 
year-to-date. Only workouts which are currently selected are included in the calculation.

Some users call us to report this calculation is in error, because they 
fail to notice that the numbers shown are the Average Calories 
Burned PER DAY. That means it is quite possible that the numbers 
shown for the last month are LESS than the number for the last 
week. These numbers are not totals, they are averages.

To see the calories burned in a single day or from a single workout, use the Select By Criteria 
function. Set the From and To dates to that single date, and, if you just want a single workout, set 
the other criteria to select that workout. Now the Calorie Calculator will show the calories for that 
day or workout only in the This Week column.

The coefficients for calories burned are in calories per mile per pound of body weight for distance 
sports, and calories per hour per pound of body weight for non-distance sports.The initial 
coefficients for running, cycling, and swimming are reasonably well established, although you can 
adjust them based on your own reading of books, articles, etc. For other sports, the initial 
coefficients will have less meaning. Feel free to adjust them based on your reading, or based on your 
comparison of the effort involved in those sports with running, cycling, and swimming.



The Print, Calculate, and Done buttons should be self-explanatory.

Your weight, weight units, and the coefficients are automatically saved in your preferences file 
(TADWIN.INI) so that you shouldnt need to reenter them (unless two or more people are using the 
program on one computer). There is only space for one weight, so if your weight has changed 
during the year, you should just enter an average value.

Calorie Calculation (Macintosh)
Both the Log and Totals windows provide you the opportunity to see estimates of the calories burned 
during the various workouts in your log. These calories are calculated based on coefficients for each 
different sport, multiplied by the distance of the activity (for distance-based workouts) or time of the 
activity (for other workouts), multiplied by your weight.

Your weight is derived in one of two ways, which are controlled by the Calories choice in the 
Configure sub-menu of the File menu.

If you are tracking your weight in your log using a keyword, then you simply need to tell the 
software what keyword you are using (e.g., Wt), and what units your weight is recorded in 
(pounds, kilograms, or stone).

Note that you don't have to enter your weight every day if you do this; whenever the program does a 
calculation, it finds the weight on the nearest day to the activity in question for which you have 
entered a weight.

If you are not tracking your weight in your log, then you can input a fixed weight which the program 
will use for the calculations. After you use the Calories menu to configure this, be sure to use Save 
Settings to save your information.

The coefficients used for the calorie calculations cannot be modified from within The Athlete's 
Diary, but they are written out in a text format into The Athlete's Diary Prefs file in the Preferences 
folder in the System folder. If you feel that the calorie estimates do not agree with your own sources 
of information, you can edit the existing coefficients found in that file, and add your own if you 
wish. Calorie coefficients are in units of calories/mile/pound for distance sports, and 
calories/hour/pound for non-distance sports (sports for which the distance measurement is 
Units/None).

Equipment Use
There are three special features of the software which are contained in the Special menu.

The first of these is Equipment Use. This feature is designed to track equipment which is used 
continuously, such as a bike chain, or a pair of running shoes for people who wear only a single pair 
(for tracking shoe mileage when you alternate pairs of shoes, see below).

To use this feature, as you are entering your workouts put the word new plus the name of your 
equipment into the Comment field on the day you change equipment new running shoes, new 
chain, etc.

Now, when you want to see the total usage on that equipment since the day you started using it, 
select Equipment Use in the Special menu to bring up this dialog window:



Equipment Use

Type in the name of the equipment you are looking for: NB 685, running shoes, chain, etc., 
and click on Calculate Equipment Use (or press Return) Starting at the latest entry in your log, 
the software searches backwards until it finds the phrase in the Comment of one of your entries. 
Once the latest entry is found, the program identifies the sport associated with that equipment, and 
then calculates the total time and distance accumulated on the equipment since the date of that entry.
Equipment Use only totals mileage from currently selected entries. Suppose you keep track of 
Cycling. You ride your road bike mostly, but when you ride your mountain bike you put Mtn bike 
in the Comment field. If you ask for Equipment Use on a new chain, the program will total up 
mileage on both bikes. But if you first use Select By Criteria to select out those workouts with 
Mtn bike in the Comment field, now Equipment Use will just show your mountain bike chain 
mileage.

Equipment Use Multiple Pairs of Shoes
Many people alternate between multiple pairs of shoes. For this situation you will not be able to use 
the Equipment Use feature described above, nor should you use the Keyword feature described in 
Chapter 4, as some people assume. Instead, heres how to do it:

When you enter your workouts, identify which pair of shoes you wore by entering the name (or an 
abbreviation) of each pair into the Comment field, e.g., Nike#2, NB#3. Now to calculate the 
mileage on a particular pair, follow this two-step process. First, use Select By Criteria (Chapter 
6) and set the Comment selection to Contains the appropriate abbreviation. Now display the Totals 
window, and the total mileage and time shown will include only that pair of shoes. Repeat these two 
steps for each pair of shoes.

Target Heart Rate
The second feature available in the Special menu is Heart Rate. Enter your age, your resting heart 
rate, and your maximum heart rate (if it is not being calculatedsee next paragraph) in the places 
provided.



Target Heart Rate Calculation

The Maximum Heart Rate Determination section provides six common formulae used to approximate 
your maximum heart rate, as well as the option to enter your own maximum heart rate directly (by 
selecting Use Entered Value instead of one of the formulae).

The Calculation Method section allows you to specify the simple method of calculation (Percentage 
of Maximum Heart Rate), which does not take into account your resting heart rate, or the more 
complex (and generally recommended) Heart Rate Reserve method which does correct for your 
resting heart rate.

The Calculate, Print and Done buttons should be self-explanatory.

Race Calculator
The third feature available in the Special menu is Race Calculator. Enter the distances you'll be 
racing (with the appropriate letter for units like 10K if the units are not your standard ones). Enter 
your estimated pace in the format matching the displayed pace unit, e.g., 21.3 if your pace is in 
miles/hour, or 7:35 if your pace is in minutes/mile. When you click on Calculate, your total time 
(not including transitions for multi-sport events) will be calculated. You can change any of the 
numbers, and click on Calculate again. Click on Done when done. Of course you don't need to 
enter all three sports.

Race Calculator (Windows)



Macintosh:

In the Macintosh version, the three sports are fixed as swim, bike, run; they can't be configured as in 
the Windows version:

Race Calculator (Macintosh)



Chapter 9: Manipulating Your Log
Backing Up Your Log
The Athlete's Diary maintains a very important document the record of hours of your hard work. 
you'll be very upset if you lose this data! The Automatic Backup preference allows you to 
automatically make a copy of your log whenever you save a new copy. This means you'll have two 
files on your disk (one of them will be one day out of date), so you'll have twice as much protection. 
This isn't enough, though.

For maximum safety, at least once a month, and better 
yet once a week, you should copy the log onto a floppy 
disk, and put that floppy disk in another room or even 
another place (like at your place of work) from your 
computer. This protects you against fire, flood, and theft. This 
may seem like unnecessary effort when nothing happens. It won't 
when something does! If you aren't sure how to do this, please 
consult the manuals that came with your computer - this is an aspect 
of using a Macintosh or Windows computer, and one you should be 
familiar with.

Its also a good idea to make a hard copy on a once/month basis at least. As you start into a new 
month, you might select the previous month using the selection criteria, and then print out only those 
entries, so that all the entries for that month will appear on the same page(s).

Dividing and Combining Logs
Two choices in the File menu provide additional manipulation capabilities for your logs. Save 
Selected As allows you to save as a separate file only the portion of your log which is currently 
selected.

When you choose Save Selected As, you'll see a dialog box giving you a number of choices:

Save Selected As Dialog Box

Save As Log saves the data as a normal Athlete's Diary log, complete with all 
information about your sports, preferences, routes, and keywords. You can use this to save 
your races in a separate file, for example.
Save Entries Only saves just your log entries (in our standard tab-delimited ASCII 
format), without the sports, etc. you'll find this useful if you want to export some or all of 
your entries to another program.



Save As Training Program saves your log with relative dates (dates in which the last 
date is set to 0, the day before that is -1, and so on). Training plans (or programs) were 
described in the previous chapter.
Append To Existing File is designed to assist in keeping a separate race log. If you 
want to do this, after you have entered your latest race in your regular log, use Select By 
Criteria to select just that entry. Now select Save Selected As and choose Append to 
Existing File and that single entry will be appended to the end of the file you select (such 
as a lifetime race log). Note: this command will append your entry to any text file you 
select. It does not check to see that the file is actually a file created by The Athlete's 
Diary.
Save as HTML File (Web page) saves the selected entries in HTML format for 
viewing by a Web browser. The next section tells you how to make use of this feature.

Another choice in the File menu is Merge, which allows you to read in a second log to merge with 
the one which is already displayed. When you do this, always open the oldest log first, then use 
Merge to add in the more recent log.

Saving and Viewing Logs in HTML Format
If you use Save Selected As in the File menu to save your whole log or selected portions of it as 
an HTML file, your log can be viewed by Web browsers such as Netscape, Mosaic, Microsoft 
Internet Explorer, etc.

Just viewing your existing log with a browser gives you one feature not present in The Athlete's 
Diary your entire Route/Workout and Comment will show in each entry (compared to viewing your 
log in the Daily Log window, where just the first one or two lines are displayed). You can get 
additional functionality by using two features of HTML embedded images and links.
Embedded images might be race photos, heart rate charts, etc., which you have scanned or otherwise 
have on your computer as either a GIF or a JPG file. To have the picture displayed in your log, 
simply put something like the following in either the Route/Workout or Comment field of an entry in 
your log:

<IMG SRC="MyPhoto.gif">

(where MyPhoto.gif is the filename of your photo, and we are assuming that the file is in the same 
folder as your log itself). you'll find that this will only really work well if you keep your pictures 
fairly small.

A link might point to a Web page you have prepared yourself, or simply a text file which might be a 
copy of an e-mail you sent to friends describing one of your races. In the second case, save the file 
with a .TXT extension, and be sure to save it as a simple text file, not in some other format such as 
MacWrite or Microsoft Word. Now in the Route/Workout or Comment field, put something like this:

<A HREF="MYRACE.TXT">Race report</A>

The <A...> and </A> sections should bracket a word or phrase which will become a link to your 
race report. The referenced file can also be a photo:

<A HREF="MYPHOTO.JPG">Race photo</A>

you'll probably find that this method of including photos as links (rather than directly as described 
above) will be more suitable for large photos.

The folder Web that is included on our disk has sample files which show you how this capability 
works. From your Web browser, use Open File or Open Local (depending on browser) to open 



the file mylog.html.

Exchanging Data with Other Software

Using the Clipboard

Depending on which window is the active window, the last item in the Edit menu will read Copy 
Selected Records, Copy Totals, Copy Graph, etc. The log entries and totals are copied to the 
Clipboard as text; graphs, journal pages, and calendar pages are copied in a graphical format.

Full Data Import/Export

In order to allow for both import and export of data from The Athlete's Diary, your training log 
is stored as a simple tab-delimited ASCII text file. Each entry in the log appears on a separate line; 
individual fields within each entry are separated by tabs. Full specifications for the information in 
each field are found in the file Data Conversion Information in the Data Conversion folder on your 
master disk (FORMAT.TXT in the Windows version). Because of this simple format, your log can be 
read by virtually every word processing program, page layout program, and database program 
available; no export function is necessary. You may, however, wish to use the Save Selected As 
menu (with either your entire or just part of your log selected), and choose Entries Only so that 
you export only your log entries themselves, not your sports, preferences, etc.

Using Other Software to Modify Your Log

There may be times when you wish to use other software not to simply read your log, but to modify 
it. You might, for example, want to make use of the global search-and-replace feature of your 
favorite word processor. If you open your log with another program and then modify it, be sure to 
save it as TEXT, not in the native format of the other software.

Macintosh only: After you modify your log with another 
program, if you double-click on the file to open it, it will open the 
word processing software, not The Athlete's Diary. To re-open 
the log with The Athlete's Diary, you can drag-and-drop (drag 
the file on top of the icon representing The Athlete's Diary and 
let go), or you can simply open The Athlete's Diary, and then 
use Open in the File menu to open the log. Once you modify the 
log and save it, it will once again belong to The Athlete's Diary 
and double-clicking will once again open the correct software.



Chapter 10: Other Topics
Sorting
The Athlete's Diary always maintains its data in chronological fashion, just like a written log. 
There is no explicit sort feature. Whenver you make an entry to the log, the software inserts it in the 
log in the correct chronological order.

Travelling
Going on a trip and don't have a portable computer? Try this. Select the last weeks worth of entries, 
then print from either the Log or Week-at-a-Glance windows. Now you'll have a mostly blank page 
with nice neat columns or boxes. Jot down your training as you travel, and then enter it into your 
computer when you return.

Printing
Depending on which window is the active window, the Print item in the File menu will read either 
Print Log, Print Totals, etc. The function of the Page Selection portion of the Print Dialog box 
depends on the window. For the Log and Totals windows, All prints the entire (or selected portion 
of) the log; From and To print just the page range indicated. For the Graph and Journal windows, All 
prints just the displayed graph or journal page. To print more than one journal page, set the From and 
To fields in the Print Dialog to the number of the first and last pages that you wish to print (the page 
number of any entry is displayed in the bottom of the Journal, between the two arrows).

Both portrait and landscape printing are supported; experiment to find which you prefer for the 
different types of output. Windows which are printed as graphics (the Graph, Journal, and 
Week-at-a-Glance windows) are automatically expanded, holding the aspect ratio constant, to fill as 
much of the printed page as possible.

The Log and Totals windows are printed (and displayed) in a monospaced font, which can be 
changed by selecting Font in the Configure sub-menu of the File menu (Mac) or by modifying the 
TADWIN.INI file (Windows). Other windows are printed using pre-selected fonts in pre-selected 
sizes.

For the remaining subjects in this chapter, Windows and Macintosh 
sections are totally different.

Windows Topics

Setting up Icons for Logs in Windows 3.1:

1. Find Program Manager on your Windows desktop. From its Windows menu, select 
the Group in which you want to put your new icon. The Group is the sub-window within 
Program Manager in which your icons appear, such as Applications or Main or The 
Athlete's Diary.

2. Select New from the File menu in Program Manager, and click on Program Item, 
then OK. A dialog box will appear. Enter a Description such as Nickys 96 Log or 
whatever other name you would like to appear under the logs icon. On the command line, 



enter TADWIN (the name of the program) followed by the DOS Filename of your log, 
e.g., TADWIN NICK96.DAT. The DOS Filename of your log is the filename that you 
assigned to your log when you saved it from within The Athlete's Diary. Enter C:\TAD 
in the Working Directory box (assuming, of course, that you installed the software in a 
directory named TAD on your C drive).

3. (Optional) To assign the proper icon to the new log, click on Change Icon, then click on 
Browse. In the directory in which you installed the software you'll find an icon file named 
TADLOG.ICO. Click on that, then click on OK. Click on OK again.

4. Click on OK, and the new icon will appear in the Program Manager window. When you 
double-click on this icon, it will start the program and open the corresponding log in a 
single step

5. Repeat these steps if you want to set up more icons for other logs (logs for different years 
or different users). Enter a different Description for each log, and change the last word on 
the Command Line to be the corresponding DOS Filename of each log.

Macintosh Topics

Configuring The Software
There are a number of ways in which you are able to configure The Athlete's Diary as you like it, 
which are found in the Configure sub-menu of the File menu.

Help Bar turns on or off the Help Bar which appears along the bottom edge of the Data Entry 
window. After you use The Athlete's Diary for a little while, the information there won't be very 
useful to you, so you can turn it off to get a little extra room on your screen for the other windows, 
such as the Log.

Fonts brings up a small dialog window which allows you to select the monospaced font and 
character size which is used in the Log and Totals windows (for display and printing). The other 
windows use fonts which are chosen for you and cannot be changed.

Color turns on or off color display in the various windows. The software will detect if you have a 
monochrome screen, and automatically turn off color. However, if you have a gray-scale screen 
(such as that found on most PowerBooks), the software displays in color unless you turn it off. 
Experiment to find the setting you prefer best.

Calories was discussed in Chapter 7.

Window Sizes and Positions
With the exception of the Data Entry window and the Button Bar, all windows in The Athlete's 
Diary can be closed and moved using standard Macintosh window techniques. All but the Journal 
and Selection windows can also be zoomed or resized. The size and position of each window that 
has been opened (even if not currently open) is saved when you use Save Settings in the 
Configure sub-menu of the File menu.

After youve used the program for a while, open each window, position and size it as you prefer it, 
and then use Save Settings to remember your configuration. Note that although you can move or 
resize a window on top of the Button Bar, when the window is first opened the software will resize it 
and move it so it does not overlap the Button Bar.

To bring a window to the top (put it in front of other windows), you can either click on any part of 
that window, click on the icon for that window in the Button Bar, or select that window name from 
the Window menu. The latter two methods will also cause the window to be created if it does not 



yet exist.

Saving Your Settings
The current value of almost all pop-up menus, the size and position of each window that has been 
opened, the current choices for font and color, the presence or absence of the Help Bar, and your 
personal information contained in the Calorie configuration window and the Heart Rate calculator, 
are all saved when you use Save Settings in the Configure sub-menu of the File menu. These 
values are recalled each time you run the program. Of course they can be changed, and new values 
saved, as you wish.

The information is saved in a file named The Athlete's Diary Prefs in the Preferences folder in your 
System Folder. This file is a simple text (TeachText) file; you can read it and edit it if you like. The 
only real reason to do so is to modify calorie coefficients, as mentioned in Chapter 8.

How Many Entries in a Log?
How many entries can you make in your log? Select About The Athlete's Diary under the 
Apple menu to see our information box. On the bottom line of the box, you'll see your current limit. 
Click anywhere in the box to dismiss it and return to the application.

What the limit is depends on how much memory is available to The Athlete's Diary. Under 
System 6s Finder (or earlier), this will depend on the memory of your computer; under System 7 (or 
System 6s Multifinder), it depends on how much memory you allocate to The Athlete's Diary. 
To increase this allocation, select the application icon on your desktop by clicking on it once, then do 
a Get Info (in the Finders File menu). Edit the Preferred Size and increase the value, as desired. 
You can only do this when you are not running The Athlete's Diary.



Chapter 11: HotSync'ing with Palm
If you have the Palm version of The Athlete's Diary, you'll be interested in HotSync'ing 
information between your desktop copy and the Palm version. The information below is also found 
in the TAD/Palm manual:

HotSync
If you want to exchange data with the Macintosh or Windows desktop versions of The Athlete's 
Diary, you'll be using the HotSync feature to accomplish one or more of these four functions:

1. Download an entire log from your desktop computer to your handheld unit.
2. Upload an entire log from your handheld unit to your desktop computer.
3. Download new (or modified) entries from your desktop to your handheld.
4. Upload new (or modified) entries from your handheld to your desktop.

We'll discuss each of these functions in turn, but first we'll discuss the one thing they have in 
common - the Athlete's Diary folder in which data must be placed to be downloaded, and in 
which data will appear after being uploaded. This location of this folder and the files it may contain 
will vary from system to system, but a typical setup is shown here, in a case where we are assuming 
that the handheld unit (your Palm) has the name "Nicky" (folder or directory names are shown in 
black, and file names in red):

Macintosh

Macintosh HD
  Palm
    Users
      Nicky
        Athlete's Diary
          Download
          Download (downloaded)
          Palm Log
          Palm Log (previous)
          MergeLog

Windows

C:
  Palm
    Nicky
      Athlete's Diary
        Download.dat
        Download.bak
        PalmLog.dat
        PalmLog.bak
        MergeLog.txt

You won't need to create any of these folders (shown in black) yourself. When you install your Palm 
(or related, e.g., IBM, Franklin, Symbol) desktop software, the main directory (shown as Palm 
above but this name may vary on your system) will be created, and, on a Macintosh, a sub-directory 
(or folder) named Users will also be created. Whenever you HotSync a handheld unit to that desktop 
computer for the first time, a new sub-folder is then created (shown here as Nicky). Note that on a 
Macintosh, the user's folder always has the same name as the handheld unit, so for example if the 
name shown on the Palm is "Bullwinkle" the folder will be called Bullwinkle. On Windows, 
however, the folder name may be different (for example, it might be "Bullwi"). And finally, the first 
time you perform a HotSync after installing The Athlete's Diary conduit, the Athlete's Diary 
folder will be automatically created. The only thing you as a user will need to be concerned with are 
the files in that folder (shown in red).

Selecting the Conduit Mode (Macintosh)

To select the action of the conduit, open the HotSync Manager, select Conduit Settings from the 
HotSync menu, then select The Athlete's Diary conduit from the list which appears and click on 
the Conduit Settings button. A dialog box will appear with the four possible choices, allowing 



you to select the HotSync action for the next HotSync and the default action for all other HotSyncs.

Selecting the Conduit Mode (Windows)

To select the action of the conduit, click the right mouse button on the HotSync Manager and select 
Custom from the HotSync menu. Select The Athlete's Diary conduit from the list which 
appears and click on the Change button. A dialog box will appear with the four possible choices, 
allowing you to select the HotSync action for the next HotSync and the default action for all other 
HotSyncs.

Downloading your log from the desktop to the handheld

When you want to install a complete log from your desktop software into your handheld version 
(either when you first get your software, or perhaps when you're about to leave for a trip, etc.), set 
the conduit setting to Download desktop log to handheld ("Macintosh overwrites handheld" on 
a Mac). Now make a copy of your log, name it Download (Macintosh) or Download.dat 
(Windows), and place it in the Athlete's Diary folder. Note that the file must have exactly this 
name to be recognized by the conduit. When you HotSync, any data (including not only workouts 
but also memorized "AutoFill" workouts, keywords, and sports information) will first be deleted 
from the handheld unit, and then the corresponding information contained in the Download or 
Download.dat file will be written to the handheld unit. After the process is complete, the desktop 
file will be renamed Download (downloaded) (Macintosh) or Download.bak (Windows) to provide 
an indication to you that that data has now been installed into your handheld unit.

A note on non-American-style dates: The Athlete's Diary on the desktop and in the Palm 
support two date styles: Month/Day/Year and Day/Month/Year. In the desktop versions, this setting 
is controlled by a preference setting within the software itself. On the handheld unit, the setting is 
controlled by the Palm's system preferences. When you are downloading data from the desktop to 
the handheld unit using The Athlete's Diary conduit, however, the date style is controlled by the 
system-wide setting in your desktop operating system (the Date & Time Control Panel on a 
Macintosh or the Regional Settings Control Panel under Windows). This means that if you want to 
download data from your desktop to the handheld unit (using either this setting of the conduit, or the 
Synchronize setting described below, you must have all three settings in agreement - desktop 
operating system setting, the Palm operating system setting, and the preference within the desktop 
version of The Athlete's Diary.

Uploading your log from the handheld to the desktop



Set the conduit setting to Upload handheld log to desktop ("Handheld overwrites Macintosh" 
on a Mac) and perform a HotSync. When you HotSync, all data (including workouts, memorized 
"AutoFill" workouts, keywords, and sports information) is written to the desktop to a file named 
Palm Log (Macintosh) or PalmLog.dat (Windows) in the Athlete's Diary folder. This file is a 
complete log, identical in format to logs which are created by the desktop version of the software, 
and can be immediately opened and used by the desktop software. When these files are created on the 
desktop, any previous version is renamed, either Palm Log (previous) (Macintosh) or 
PalmLog.bak (Windows).

Important: If you are not using The Athlete's Diary on your desktop, but you do 
choose to use The Athlete's Diary conduit instead of the standard Backup Conduit, 
this setting is probably the one you'll want to use, so that your log will be 
regularly backed up to the desktop; otherwise if anything happens to your Palm you 
will lose all your stored data, not a good thing!

Downloading new or modified entries from the desktop to the handheld

This is the trickiest operation, because, unlike the standard Palm applications, the desktop version of 
The Athlete's Diary does not keep track of "dirty" (new or modified) entries. In most cases, 
however, you'll simply be adding new entries at the "end" (chronologically) of your log, so you can 
separate out those new entries yourself. Use the Select By Criteria feature of your desktop 
software to select those workouts by date, then use Save Selected As in the File menu to save 
just those workouts as Download (Macintosh) or Download.dat (Windows) in your Athlete's 
Diary folder (the one in the Palm folder shown above, not the one in which your log for the desktop 
version is stored). Now set the conduit setting to Synchronize, and when you HotSync, the new 
workouts are downloaded to the handheld unit and appended to the existing workouts (and 
automatically sorted into place chronologically).

Uploading new or modified entries from the handheld to the desktop

Set the conduit setting to Synchronize, and when you HotSync, any "dirty" (new or modified) 
entries on the handheld unit are uploaded to the desktop in your Athlete's Diary folder, to a file 
named Palm Log (Macintosh) or PalmLog.dat (Windows) (with previous files being renamed as 
noted above). These files are not "complete" Athlete's Diary logs but contain only new or modified 
workouts which have been entered on the handheld (changes to sports, keywords, and AutoFill 
workouts are not included). After the data are uploaded, they must be merged into your desktop log. 
This can happen in one of two ways:

AutoMerge (Windows)

When the data are uploaded, the conduit looks for a text file named MergeLog.txt 
in your Athlete's Diary folder. If such a file exists, the contents of that file are 
read and interpreted as the name of the desktop log file into which the uploaded 
data will be merged.So for example if the file named MergeLog.txt contains a 
single line of text reading as follows: C:\TAD\MyLog.DAT, then after new 
workouts are uploaded into the PalmLog.dat file, they will then be automatically 
merged into C:\TAD\MyLog.DAT. The file MergeLog.txt is itself automatically 
created by the software, and will be filled in with the name of the log last opened 
by your desktop version of Athlete's Diary. So if you create a log on a desktop, 
save it, exit the program, then open that log one more time and exit the program, 
MergeLog.txt will be filled in properly, and you won't need to do anything else 
for data uploaded from the handheld to be automatically merged into your desktop 
log (merging new entries from the desktop into the handheld remains a "two-step" 
process as described above).



You can also change MergeLog.txt yourself to point to any desktop log, by 
simply editing the contents of the file with an application like NotePad. Note that 
this feature actually allows multiple Palms to be synchronized using the same 
computer, to different desktop logs, since each Palm unit has its own Athlete's 
Diary folder and hence its own unique MergeLog.txt file.

AutoMerge (Mac)

When the data are uploaded, the conduit looks for a file named MergeLog in your 
Athlete's Diary folder. If such a file exists, the contents of that file are read 
and interpreted as the name of the desktop log file into which the uploaded data 
will be merged. MergeLog should be a simple text file, which you can create either 
with a "plain text editor" like SimpleText or Tex-Edit, or with a word processing 
program like ClarisWorks. In the latter case you must make sure to save the file in 
"Text" format and not in "ClarisWorks" format. If the contents of MergeLog are a 
"simple" filename, like "Nicky's Log" (do NOT include the quotes when entering 
the name), then the software will assume that the file is in the SAME folder as the 
MergeLog file itself (the Athlete's Diary folder). Alternatively, you can put in a 
"complete filename", where each "level" of directory is separated by a colon, like 
this: Macintosh HD:Personal:Logs:Nicky's Log. In this example, you have a 
hard disk named "Macintosh HD", on that disk is a folder named "Personal", in 
that folder is a sub-folder named "Logs", and in that folder is your desktop 
Athlete's Diary log named "Nicky's Log".

Manual Merge

If you don't want to use the automatic method, or for some reason it doesn't 
appear to be working, you can use the manual method. After performing the 
HotSync, open your desktop log with the desktop version of the software, select 
Merge from the File menu and read in the Palm Log (Mac) (or PalmLog.dat on 
Windows) file containing the uploaded data. Make sure you do this before 
the next HotSync, before you lose the data in in your Palm Log file. 
If you make a mistake and do perform another HotSync before opening your 
desktop Athlete's Diary and using Merge, you'll still be able to Merge the 
data, but it will now be in the renamed file (Palm Log (previous) on the Mac or 
PalmLog.bak on Windows).

And finally, setting the conduit setting to Do nothing...does nothing.



Appendix I: Using the Sample Log
Using The Sample Log
If you want to get a quick overview of the functioning of The Athlete's Diary, just follow these 
step-by-step instructions (Ignore case. When the instructions say Type R, just type a lower-case r to 
save effort):

1. Start the program by double-clicking on The Athlete's Diary icon in Program 
Manager (Windows 3.1), by selecting The Athlete's Diary from the Start Menu 
(Windows 95), or by double-clicking on the program (Macintosh). Use Open in the File 
menu to open the file TESTLOG.DAT (on, on a Mac, just double-click on the Sample Log 
file).

2. Lets add today's run. Press Tab, then type R, and "Running" will appear in the Sport. 
Press Tab. Press Tab again. Now type 3.5, then press Tab and 3.5M will appear in the 
Distance field. Type 2542, press Tab, and the Pace (7:21) is automatically calculated. 
Type Apple loop as the Route, press Tab, then Feeling good as the Comment. Press 
Enter or click on the Enter button and your new entry will appear on the bottom of the 
screen. Use the scroll bar to scroll through the log.

3. "Apple loop" is actually one of our "memorized workouts," so lets enter the data again even 
quicker. Click and hold the mouse on the word Route/Workout in the Data Entry 
Window. Drag the mouse down the list of memorized workouts until you select Apple 
loop, and then release the mouse button. Now type 2542, press Enter, and the new entry 
is added.

4. How did today's run compare to previous runs on the same route? Under the Select menu, 
find By Route and then select Apple loop.

5. Press Ctrl-A (Windows) or A (Mac) to redisplay all entries. Select Totals from the 
Window menu to examine your totals.

6. Select Week-at-a-Glance from the Window menu to view the Calendar. Use the 
Display menu to switch between the One Week and Four Weeks views.

7. Select Graph in the Window menu and a graph of hours/week of activity will appear. 
Using the Display menu, change from All to Running; a graph of hours/week running 
will appear. Use the Graph menu to change to Distance, then Pace.

8. Now lets graph a Keyword. Under the Display menu, select Keyword Totals, and 
choose Weight (lbs). A graph of weight will appear.

9. Press Ctrl-Q (Windows) or Q (Mac) to exit the program. you'll find an updated copy of 
the sample log on your disk (because you made an entry and Automatic Save was selected 
as a preference), as well as a file named TESTLOG.BAK (Windows) or Sample Log 
Backup (Mac) (because Automatic Backup was selected as a preference), which is the log 
before you made any changes.



Appendix II: Starting Your Own Log
Starting Your Own Log
If you want to start your own log without reading the whole manual, just follow these step-by-step 
instructions. Ignore case. When the instructions say Type R, you should really type a lower-case r to 
save effort.

1. Start the program by double-clicking on The Athlete's Diary icon in Program 
Manager (Windows 3.1), by selecting The Athlete's Diary from the Start Menu 
(Windows 95/98/2000/ME/NT), or by double-clicking onThe Athlete's Diary (Mac).

2. Select New under the File menu.
3. The Preferences window appears. It will be set to default preferences. Feel free to change 

them, otherwise just click on done.
4. The Sports window will appear, but with no sports entered. Lets add Running and Cycling. 

Click on Running. The Abbreviation will automatically switch to R (Windows) or enter R 
(Mac), the Units to miles, and the Pace to Min/Mile (on the Mac you need to select the Units 
and Pace). Assuming you like these choices, click on the Add button to add Running to 
your list. It will appear at the lower right in the Sports List box. Now click on Cycling. 
Now Abbrev. will be C and Units will be miles. Click on Miles/hour under Pace, and then 
click on the Add button to add this sport to your list. Now click on the Done button to exit 
and save your sports. Click on OK when reminded to send in your registration card (and do 
it!).

5. you'll now be looking at a log but it will be empty. You probably want to make some 
entries (maybe all your entries for the year so far, or just this month). Most users start their 
log on January 1, of course, but the software doesn't require that. If you want your log to 
start on some other day, thats fine.

6. The date will probably be wrong if you're entering old data. Since the date is selected, just 
type in the new date and it will replace the displayed one. Assuming the entry is from this 
year, just type the day and month (e.g., 2/27) and press Tab. Type the sport letter (R or 
C), and press Tab. Press Tab again unless the entry is an interval workout or race. Type 
the distance (e.g., 7.5), and press Tab. Type the time (e.g., 5523) and press Tab. Type 
in the Route, press Tab, then a Comment if you wish, then press Enter. Repeat for all the 
entries you wish to add.

7. Select Save under the File menu. The first time you do this, you'll have to type in a 
filename in the box before clicking on Save. you'll need to give your log a filename at this 
point. If you are using Windows 3.1, this name must conform to DOS conventions and end 
in the letters DAT, like MYLOG.DAT (using other versions of Windows or on a Mac 
you can use any name).

If you are entering dozens of entries (as many people do when they 
first get the software and are typing in this years training), you 
should save your log after every dozen or so entries. Better safe than 
sorry!

8. Select Exit under the File menu .
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